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LOUDSPEAKER MODELS

Direct Radiator in an Infinite Baffle

Direct Radiator in a Closed-Box Enclosure

Direct Radiator in a Vented-Box Enclosure

Sixth or Eighth Order Band Pass Enclosure



Aperiodic Bi-Chamber Enclosure

Damped Transmission Line Enclosure

Front-Loaded Horn

Back-Loaded Horn

Horn-Loaded Vented-Box Enclosure With Port Exit Located Outside Horn Mouth
Horn-Loaded Vented-Box Enclosure With Port Exit Located Inside Horn Mouth
Mass-Loaded Horn

Offset Driver Horn

Two-Way or Three-Way Multiple Entry Horn

Tapped Horn

Compound Horn

[INTRODUCTION

This application calculates the theoretical acoustical impedance, acoustical power, electrical
impedance, diaphragm displacement, phase response and group delay versus frequency
characteristics of finite and infinite horn loaded loudspeakers.

Finite horns radiating into free space, half space, quarter space or eighth space can be analysed (4
x Pi, 2 x Pi, Pi or Pi/ 2 steradians solid angle).

Horn systems can have an oblate spheroidal waveguide, a single Le Cléac'h, tractrix, radius,
spherical wave or Salmon's family hyperbolic-exponential flare segment, or up to four conical,
exponential and/or parabolic flare segments connected in series, coupled to a throat chamber,
loudspeaker driver and acoustically lined or vented rear chamber. Horns with multiple drivers and
arrays of multiple loudspeakers can be modelled.

A parabolic (Par) flare should be used when simulating a rectangular cross-sectional area horn
segment having two parallel straight sides and two sloping straight sides, where the area varies
linearly with axial length.

Horn segment parameter values can be reset to zero by entering a blank for the throat area,
mouth area, axial length, flare cutoff frequency, flare parameter or throat entry half-angle.

For multiple-segment horns, the more that the value of Cir (mouth circumference in flare cutoff
frequency wavelengths) exceeds 1 for any horn segment, the less accurate the calculated throat
acoustical impedance and other results become.

The application assumes that the velocity of sound in air is 344 metres per second, and that the
density of air is 1.205 kilograms per cubic metre.

The driver diaphragm is modelled as a rigid plane circular piston. No allowance is made for
frequency-dependent directional characteristics due to driver cone angle or cone material, or for
changes in moving mass, acoustical impedance or radiated power caused by diaphragm
resonance modes.



Horn transmission losses are assumed to be zero, unless absorbent filling material is specified.

[INPUT PARAMETERS WINDOW

Moving the mouse pointer over an object or message on the input parameters window displays a
context-sensitive explanatory note in the status bar panel at the bottom of the window.

After calculating results by pressing F5 or clicking the Calculate button, press F2 to move to the
next window, Shift+F2 to move to the previous window or Esc or F5 to return to the input
parameters window from any result window.

To enter a length, area or volume value in Imperial inch or foot units, press F6 in edit mode when
the relevant input parameter has the focus.

|Radiation, Amplifier and Mouth Parameters

Ang Solid radiation angle (steradians).
Enter 4, 2, 1 or 0.5 for finite horn, O for infinite horn, or
double-click the angle parameter.
Eg Amplifier open circuit root-mean-square voltage (volts).
Enter O for driver diaphragm constant rms velocity of 10 centimetres
per second.
Rg Amplifier output resistance (ohms).

Cir Free space normalised horn mouth circumference in flare cutoff
frequency wavelengths.

Fta Horn mouth flare tangent angle (degrees).

[Horn Parameters

S1 Horn segment 1 throat area (sq cm).
S2 Horn segment 1 mouth area and horn segment 2 throat area (sq cm).

L12 Horn segment 1 axial length (cm).
To select Con, Exp or Par flare in edit mode, press C, E or P when
the relevant horn segment length parameter has the focus or double-
click the length label. The length value must be non-zero to
preserve the flare setting. To select Hyp, Lec, Obl, Rad, Sph or Tra
flare in edit mode, press H, L, O, R, S or T when the L12 length
parameter has the focus.



F12 Horn segment 1 flare cutoff frequency (hertz).

T  Hyperbolic-exponential and Le Cléac'h horn flare parameter.
Enter O for catenoidal, < 1 for cosh, 1 for exponential, > 1 for sinh
or 99999.99 for conical.

R Radius horn flare profile radius (cm).

AT Horn throat entry half-angle (degrees).
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|Driver Parameters

Sd Driver diaphragm piston area (sq cm).

Bl Driver magnetic flux density x voice coil conductor length (tesla.m).
Cms Driver diaphragm suspension mechanical compliance (m/newton).
Rms Driver diaphragm suspension mechanical resistance (newton.sec/m).

Mmd Driver diaphragm and voice coil dynamic mechanical mass (gm).
Mmd equals Mms (total moving mass) minus air load.

Le Driver voice coil inductance (millihenrys).
Re Driver voice coil dc resistance (ohms).
Nd Number and position of drivers in loudspeaker.
Specify driver system configuration using the Driver Arrangement

tool.

fs Driver free-air resonance frequency (hertz).



Vas Volume of air that provides a restoring force equal to that of the
driver's mechanical compliance (litres).

Qes Driver resonant electrical Q at the driver resonance frequency, due
solely to inherent electromagnetic damping.

Qms Driver resonant mechanical Q at the driver resonance frequency, due
solely to internal mechanical damping.

Qts Driver total Q.

|[Chamber Parameters

Vrc Rear chamber volume (litres).

Lrc Rear chamber average length (cm).

Fr Rear chamber acoustical lining airflow resistivity (mks rayls/m).

Tal Rear chamber acoustical lining thickness (cm).

Frl Absorbent filling material airflow resistivity (mks rayls/m).

Tall Absorbent material filled length (cm and percent).

Ap Vented rear chamber port cross-sectional area (sq cm).

Lpt Vented rear chamber port tube length (cm).

Apl Throat port or throat adaptor entry cross-sectional area (sq cm).

Lp Throat port tube or throat adaptor length (cm).

Vitc Throat chamber volume (cc).

Atc Throat chamber average cross-sectional area normal to axis (sgq cm).

The rear chamber volume is the effective enclosed air volume behind the driver diaphragm,
including any space occupied by acoustical lining material but excluding port tube, driver magnet

and chassis assemblies.

The throat chamber volume is the effective air volume between the driver diaphragm and the
throat chamber port, the throat adaptor entry or the horn throat.

The locations of the throat chamber and rear chamber are as shown in the schematic diagram.

Set relevant values to zero if no throat chamber, rear chamber, acoustical lining, port tube or
throat adaptor.



IDEFAULT RESULT WINDOWS

|Schematic Diagram

Loudspeaker schematic diagram and system volume. The design is assumed to be axisymmetric.
Use the mouse pointer to identify component parts and show scale.

|Acoustical Impedance

Horn throat acoustical resistance and reactance in normalised acoustical ohms versus frequency in
hertz. The actual cgs acoustical resistance and reactance can be determined by multiplying the
chart values by the given scaling factor.

|Acoustical Power

Constant directivity sound pressure produced at a point source normalised distance of one metre
when the driver is supplied with a signal of a given voltage, versus frequency in hertz. The level is
expressed in decibels relative to the standard reference sound pressure of 20 micropascals.

The Directivity Response tool can be used to take into account the frequency dependent directional
characteristics of direct radiating single drivers and finite single-segment horns.

|[Electrical Impedance

Loudspeaker electrical input impedance magnitude in ohms versus frequency in hertz.

|Diaphragm Displacement

One-way maximum displacement of the driver diaphragm from its mean position in millimetres for a
specified input signal, versus frequency in hertz. The actual displacement can be determined by
dividing the chart value by the scaling factor, where given.

Behaviour at all input voltage levels is assumed to be linear. No allowance is made for low
frequency high power amplitude compression.

Each diaphragm in a multiple driver configuration has the same displacement, as given by the
calculated value.

|[Phase Response




Phase-angle difference in degrees between the input voltage and the output sound pressure of a
loudspeaker system, versus frequency in hertz.

By default, the phase is corrected by adding a linear phase offset equivalent to the mean group
delay across the -12 dB delimited SPL bandwidth. Use the Delay tool to specify a different offset
correction value or to display standard wrapped phase.

|Group Delay

Negative derivative in milliseconds of the loudspeaker system phase response, versus frequency in
hertz.

Group delay is a measure of the rate of change of phase with respect to frequency, and is positive
when the phase slope is negative.

ITOOLS MENU

|Radiation Angle

Specifies the placement of the loudspeaker, and the solid angle into which the loudspeaker
radiates. The solid angle is measured in steradians. Set the value to zero to specify an infinite
horn.

The Tools menu command is enabled when Ang has the focus. The tool can also be selected by
double-clicking the parameter in edit mode.

|[Horn Segment Wizard

Calculates either the throat area, mouth area, axial length, flare cutoff frequency, flare parameter,
throat entry half-angle, mouth circumference in cutoff frequency wavelengths or mouth flare
tangent angle, given the other relevant horn segment parameters. Cir or Fta can be setto a
specified value when the mouth area or flare cutoff frequency calculation option is selected.

The Tools menu command is enabled when any horn segment parameter or the Apl throat
adaptor parameter has the focus. The tool can also be selected by double-clicking the parameters
in edit mode. The mouth area calculation option can be used to determine the cross-sectional area
at any point along the axial length of a horn segment. For system volume, double-click segment
volume.

|Calculate Parameter




Derives BIl, Cms, Rms and Mmd values from relevant Thiele-Small parameters, calculates Eg given
the power delivered to a specified load and determines Lpt given the Helmholtz resonance
frequency.

When selected from Sd, displays the driver Thiele-Small parameters Sd, Re, fs, Vas, Qes, Qms
and Qts, and the electro-mechanical parameters Le, Pmax and Xmax. The values of all
parameters shown can be edited, except for Qts.

The Tools menu command is enabled when Eg, Sd, Bl, Cms, Rms, Mmd or Lpt has the focus.
The tool can also be selected by double-clicking the parameters in edit mode.

|[Chamber Type

Specifies a lined or vented rear chamber, a ported throat chamber or a throat chamber coupled to
the horn throat by a conical adaptor.

The Tools menu command is enabled when the input parameters window is in edit mode. The
chamber configuration can also be selected by double-clicking the Fr, Tal, Ap, Lpt, Apl or Lp label.

|Driver Arrangement

Specifies the number and position of driver modules connected electrically in series and/or parallel.
A driver module can contain a single driver, or up to 9 drivers connected in a series or parallel
isobaric configuration.

Multiple drivers share the horn system, throat chamber and rear chamber as defined by the input
parameter values and as shown in the schematic diagram. An offset driver horn, a tapped horn, a
compound horn, a multiple entry horn or a 6th or 8th order band pass enclosure can be specified.

Select the tool by double-clicking the Nd, OD, TH, TH1, CH, ME1, ME2, BP6 or BP8 disabled text
box in edit mode.

|System Design With Driver

Determines the optimum design for a hyperbolic-exponential horn loudspeaker given the driver
parameter values and the required operating frequency range. Horn flare parameter T can be
entered as an optional input by double-clicking the upper rolloff corner frequency label. The tool is
enabled when the input parameters window is in edit mode.

|System Design From Specifications

Determines the optimum design for a hyperbolic-exponential horn loudspeaker given the system
parameter values and the required operating frequency range.

|Loudspeaker Wizard



Automatically re-calculates the results for a specified loudspeaker system in real time, as input
parameter values are changed. The tool is applicable to direct radiator loudspeakers, single
segment conical and parabolic horns, and all multiple segment horns.

Absorbent filling material can be included in the horn segments of a Loudspeaker Wizard system
by selecting the Filling option.

The airflow resistivity of the absorbent filling material in each segment is specified in mks rayls/m
using the Frl slider controls. If a Frl slider value is changed while the F5 function key is pressed,
all segments are set to the same resistivity value.

The Tall sliders can be used to partially fill segments with absorbent material. The first half of the
slider fills the segment from the throat end, and the second half fills the segment from the mouth
end. For horn 2 in a compound horn system, the first half of the slider fills the segment from the
mouth end, and the second half fills the segment from the throat end. If a Talll slider value is
changed while the F5 function key is pressed, all segments are filled to the same percentage
value.

When the airflow resistivity value is less than 1000 mks rayls/m and the Schematic and Filling
options are selected, the total amount of Polyfill absorbent material required to achieve the
specified resistivity value is shown in kilograms. Double-click on the total value to display the
amount in the currently selected segment.

The initial slider control settings and chart results are saved as a reference baseline when the tool
is selected. Up to four sets of values can be temporarily stored and recalled while the Wizard is
open by clicking the appropriate memory button or pressing the equivalent function key.

Pressing Ctrl+C when the power response chart is displayed captures the current results.
Pressing Ctrl+V shows or hides previously captured results. Not applicable when room gain is
included.

Press the S key to instantly check the schematic diagram.

To change the flare of a horn segment, double-click on the label above the length slider control. To
change the Manual / Auto setting of an area slider control, double-click on the label above the area
slider. To change the frequency range, double-click on the chart frequency label.

To directly set a slider control to a specified value, key in the value and then press Enter while the
control has the focus. For the Tall slider, a directly entered positive percentage value will fill the
currently selected segment with absorbent material from the throat end, and a directly entered
negative percentage value will fill the segment from the mouth end. For horn 2 in a compound
horn system, a directly entered Tall positive percentage value will fill the currently selected
segment with absorbent material from the mouth end, and a directly entered negative percentage
value will fill the segment from the throat end.

To quickly move through a slider control value range, press and hold the Home or End key while
the slider has the focus.



To reset a slider control to its baseline value, press B while the control has the focus. To reset all
slider controls to their baseline values, press Alt+B. To save a new baseline with the current slider
control settings and chart results, press Ctrl+Alt+B.

Imported room gain data can be included in the Loudspeaker Wizard acoustical power results by
either clicking the Include Gain button in the Memory window or pressing the F7 function key.

The active or parametric equaliser filter option in the Filter Wizard tool can be selected from the
Loudspeaker Wizard by either clicking the Filter Wizard button in the Memory window or pressing
the F8 function key.

[Multiple Entry Horn Wizard

Automatically re-calculates the results for a specified two-way or three-way multiple entry horn
loudspeaker system in real time, as input parameter values are changed.

CoEntrant, Unity and Synergy loudspeakers are examples of multiple entry horn systems.

A Nd record is used to specify the horn system and HF driver at the horn throat. A MEL1 record is
used to specify the MF drivers at the first offset entry point and a ME2 record is used to specify the
LF drivers at the second offset entry point.

A three-way system requires the Nd record to have at least three segments, and both a ME1 and
a ME2 record to be activated.

A two-way system requires the Nd record to have at least two segments, and a ME1 record to be
activated. If a ME2 record is also activated it will be disregarded if only two segments are specified
in the Nd record.

The Tools menu command is enabled when the input parameters window for a Nd record is in edit
mode and at least two horn segments have been specified, and a ME1 record has been previously
activated.

The initial slider control settings and chart results are saved as a reference baseline when the tool
is selected. Up to four sets of values can be temporarily stored and recalled while the Wizard is
open by clicking the appropriate memory button or pressing the equivalent function key.

Pressing Ctrl+C when a power response chart is displayed captures the current results. Pressing
Ctrl+V shows or hides previously captured results.

Press the S key to instantly check the schematic diagram.
To change the flare of a horn segment, double-click on the label above the length slider control. To
change the Manual / Auto setting of the S2 area slider control, or S3 area slider control if three-

way, double-click on the label above the area slider.

Pressing the Ctrl key while adjusting an Amplifier Eg or Rg slider control sets the other Eg or Rg



sliders to the same value.

To change the alignment type of a band pass filter, double-click on the alignment label. To
change the slope units from dB per octave to dB per decade, double-click on the slope label.

To switch a band pass filter on or off, double-click on the On / Off label for that filter.

To change the frequency range, double-click on the chart frequency label. To directly set a slider
control to a specified value, key in the value and then press Enter while the control has the focus.

To quickly move through a slider control value range, press and hold the Home or End key while
the slider has the focus.

To reset a slider control to its baseline value, press B while the control has the focus. To reset all
slider controls to their baseline values, press Alt+B. To save a new baseline with the current slider
control settings and chart results, press Ctrl+Alt+B.

Select the Schematic option to display the schematic diagram of the specified two-way or three-
way multiple entry horn loudspeaker system.

Select the Power 1 option to display the horn mouth acoustical power output of the driver
assembly located at the horn throat. The baseline shows the total horn mouth acoustical power
output.

Select the Power 2 option to display the horn mouth acoustical power output of the driver
assembly located at the first offset entry point. The baseline shows the total horn mouth
acoustical power output.

Select the Power 3 option to display the horn mouth acoustical power output of the driver
assembly located at the second offset entry point. The baseline shows the total horn mouth
acoustical power output.

Select the Total Power option to display the acoustical power output of the complete system.

Select the Impedance 1 option to display the magnitude of the electrical input impedance of the
driver assembly located at the horn throat.

Select the Impedance 2 option to display the magnitude of the electrical input impedance of the
driver assembly located at the first offset entry point.

Select the Impedance 3 option to display the magnitude of the electrical input impedance of the
driver assembly located at the second offset entry point.

Select the Displacement 1 option to display the driver diaphragm displacement of the driver
assembly located at the horn throat.

Select the Displacement 2 option to display the driver diaphragm displacement of the driver
assembly located at the first offset entry point.



Select the Displacement 3 option to display the driver diaphragm displacement of the driver
assembly located at the second offset entry point.

|Driver Front Volume

Calculates the effective air volume between the driver diaphragm and the front plane of the driver,
given D1 the inside diameter of the mounting sealing strip, D2 the inside diameter of the diaphragm
suspension, D3 the diameter of the dust cap, H1 the thickness of the sealing strip, H2 the
perpendicular distance from the front plane to the edge of the dust cap, and H3 the perpendicular
distance from the front plane to the centre of the dust cap.

The Tools menu command is enabled when the input parameters window is in edit mode. The
tool can also be selected by double-clicking the Vtc or Atc label or text box in edit mode.

|View Schematic

Displays the loudspeaker schematic diagram and system volume.

The Sample menu command can be selected from any default chart window, or by pressing F3 or
double-clicking the chart.

Single-clicking a chart will provide abbreviated data at the frequency given by the mouse pointer
location. The sampling frequency can be changed by dragging the red marker line, or by using the
Up, Down, Left, Right, Home or End navigation keys. Press the Esc key to release a set
frequency point.

Acoustical impedance chart ~ Calculates the normalised throat acoustical resistance and
reactance and the actual throat acoustical resistance and reactance at any given frequency
between 1 and 20000 hertz.

Acoustical power chart ~ Calculates the constant directivity sound pressure level, electrical input
power, acoustical output power, power conversion efficiency, horn throat peak sound pressure and
horn throat peak particle velocity at any given frequency between 1 and 20000 hertz. When a
single-segment horn is sampled the second-harmonic distortion is also calculated. When the
maximum SPL response is sampled the acoustical output is shown as either power or
displacement limited, and the input voltage and Pmax diaphragm displacement are given. When
the power compression response is sampled the thermal power compression is also shown,
expressed in decibels.

Electrical impedance chart ~ Calculates the driver electrical input impedance magnitude and
phase at any given frequency between 1 and 20000 hertz.

Diaphragm displacement chart ~ Calculates the driver diaphragm mean-to-peak displacement,
peak velocity and peak acceleration at any given frequency between 1 and 20000 hertz. When



the Maximum SPL tool has been selected the sampled displacement is shown as either power or
displacement limited. When displacement limited, the Pmax displacement value is also given.

Phase response chart ~ Calculates the system corrected phase shift or the system standard
wrapped phase shift at any given frequency between 1 and 20000 hertz.

Group delay chart ~ Calculates the system group delay, equivalent distance travelled and
equivalent wavelengths at any given frequency between 1 and 20000 hertz.

Beam width chart ~ Calculates the directivity pattern -6 dB beam width at any given frequency
between 1 and 20000 hertz.

|[Compare

Displays the current and previous or captured acoustical impedance, acoustical power, acoustical
pressure, electrical impedance, diaphragm displacement, phase response, group delay or beam
width results on the same chart.

Previous results are used in comparisons by default. Press Ctrl+C to capture the current results
or Ctrl+R to release captured results. Results can also be captured or released by right-clicking
on any chart.

Press F4 to show or hide the previous or captured results.

Calculates the acoustical power output from the front side of the driver, the acoustical power
output from the rear side of the driver, or the combined front and rear acoustical power outputs.
The chosen output option is retained until changed by the user, or until a different record is
selected, at which time the default output option is restored. The default option calculates the
combined acoustical power output.

For a direct radiator in a vented-box enclosure loudspeaker system, the Combined output option
combines the direct radiator acoustical power output with the port acoustical power output.

The path length from the rear side of the driver diaphragm to the port outlet is assumed to be
equal to Lrc plus Lpt, as shown in the schematic diagram.

The distance from the port outlet to the listener can be adjusted if necessary using the path length
difference parameter. A positive value for path length difference increases the listener distance.

The path length difference is the distance from the port outlet to the listener minus the distance
from the direct radiator diaphragm to the listener. The difference is positive when the distance from
the port outlet to the listener is greater than the distance from the direct radiator diaphragm to the
listener.

Press the F9 function key to permanently save the entered path length difference value.



For a finite damped transmission line enclosure loudspeaker system, the Combined output option
combines the transmission line acoustical power output with the direct radiator acoustical power
output.

For a finite front-loaded horn loudspeaker system with no rear chamber, the Combined output
option combines the horn acoustical power output with the direct radiator acoustical power output.

For a finite back-loaded horn loudspeaker system, the Combined output option combines the horn
acoustical power output with the direct radiator acoustical power output. The direct radiator
cannot be located inside the horn mouth.

For a finite horn-loaded vented-box enclosure loudspeaker system, the Combined output option
combines the horn acoustical power output with the port acoustical power output.

For a finite offset driver horn loudspeaker system, the Combined output option combines the horn
acoustical power output with the direct radiator acoustical power output or the port acoustical
power output.

For a finite compound horn loudspeaker system, the Combined output option combines the horn 1
acoustical power output with the horn 2 acoustical power output.

|Directivity Response

Displays the far-field acoustical pressure of a direct radiating single driver, a finite single-segment
non-negative flare horn with no throat adaptor, or a port at a specified off-axis angle, taking into
account the frequency-dependent directional characteristics of the radiating system.

Select from the acoustical power or acoustical pressure chart window.

|Directivity Pattern

Displays the directional characteristics of a direct radiating single driver, a finite single-segment
horn with no throat adaptor, or a port at a specified frequency. The polar diagram shows the far-
field sound pressure at a fixed distance as a function of the off-axis angle, expressed relative to
the on-axis pressure with the maximum value normalised to 1. The sound pressure ratio can be
indicated directly or in decibels. The on-axis directivity index and -6 dB beam width are also given.
Click on the polar diagram to show the pressure level at a specified angle. For a direct radiating
single driver, the value of ka (wave-number k = 2 * Pi * f / ¢ multiplied by piston radius a) is also
given.

Select from the acoustical power, acoustical pressure or beam width chart windows.

|Directivity Beam Width

Displays the angular distance in degrees between the two points on either side of the principal



axis of the directivity pattern where the sound pressure level is down 6 decibels from its value on
axis, versus frequency in hertz.

Select from the acoustical power or acoustical pressure chart window. Only applicable to direct
radiating single drivers, finite single-segment horns with no throat adaptor, and ports.

|Directivity Polar Map

Displays the far-field sound pressure at a fixed distance as a function of the off-axis angle in
degrees, versus frequency in hertz. Click the check box to show the results normalised to the on-
axis response.

Results can be sampled by moving the mouse pointer over the chart window. A specific point can
be selected by clicking or dragging on the window, and by using the Up, Down, Left and Right
navigation keys. Press the Esc key to release a set point.

Select from the acoustical power, acoustical pressure or beam width chart windows. Only
applicable to direct radiating single drivers, finite single-segment horns with no throat adaptor, and
ports.

[Impulse Response

Displays the impulse pressure versus time response of a loudspeaker system. The maximum
positive or negative amplitude value is normalised to 0.9 and the maximum peak is positioned by
default at the 0 msec reference point.

Select from the acoustical power or acoustical pressure chart window.

Click the Export button to save the impulse response data values to a wave sound file. Click the
Compare or Clear button or press F4 to show or hide the comparison with the previous result.

[Impulse Spectrogram

Displays the impulse spectral density, or normalised amplitude in decibels as a function of
frequency, versus time in milliseconds.

Select from the acoustical power or acoustical pressure chart window.
Results can be sampled by moving the mouse pointer over the chart window. A specific point can
be selected by clicking or dragging on the window, and by using the Up, Down, Left and Right

navigation keys. Press the Esc key to release a set point.

|[Room Gain Excluded

Displays the power response with imported room gain data excluded.



|[Room Gain Included

Displays the power response with imported room gain data included.

|[Room Gain Profile

Displays the room gain data only.

[Maximum SPL

Displays the maximum sound pressure level in decibels that can be achieved at 1 metre without
exceeding the driver rated thermal limited electrical input power Pmax or the diaphragm linear
mean-to-peak displacement limit Xmax, versus frequency in hertz. Set Xmax to 99.9 to remove the
displacement limit.

Black indicates power limited, red indicates displacement limited.

Press the F9 function key to permanently save the entered Pmax and Xmax values.

|Power Compression

Displays the thermal power compression response for a given driver input voltage and voice caoill
temperature, taking into account the increase in voice coil resistance due to the coil being heated
above the standard reference value of 20 degrees Celsius.

The value of the increased voice coil resistance due to heating is displayed in the status bar panel
at the bottom of the input parameters window when the mouse pointer is moved over the Re text
box.

The design maximum voice coil temperature for a driver is typically about 200 degrees Celsius.
The Re input parameter value is assumed to be the resistance of the voice coil at 20 deg C.

In most cases the specified driver voice coil temperature will be an estimate only, due to the
difficulty in determining the actual precise temperature. The response results should therefore be
taken as indicative and not exact.

[Multiple Speakers

Displays the acoustical power output response of a given multiple loudspeaker array connected to
a single amplifier. Not applicable to infinite horns.

|Filter Wizard




Automatically re-calculates the results for a specified filter system in real time, as input parameter
values are changed. The Le Cléac'h high pass passive filter option provides for two-stage
impedance equalisation and high frequency uplift.

Select from the acoustical power or acoustical pressure chart window. The tool is disabled when
Eg is set to zero, or when maximum SPL has been calculated.

Select the Schematic option to display the network schematic diagram of the specified passive filter
Select the Power or Pressure option to display the acoustical power or acoustical pressure of the
specified passive or active filter and loudspeaker system.

Select the Impedance option to display the magnitude of the electrical input impedance of the
specified passive filter and loudspeaker system.

Select the Displacement option to display the driver diaphragm displacement of the specified
passive or active filter and loudspeaker system.

Select the Delay option to display the group delay of the specified passive or active filter and
loudspeaker system.

Select the Impulse option to display the impulse response of the specified passive or active filter
and loudspeaker system.

Select the Filter Gain option to display the gain response of the specified active filter.

Select the Filter Phase option to display the phase response of the specified passive or active filter.
Select the Filter Delay option to display the group delay of the specified passive or active filter.
The initial chart results are saved as reference baselines when the tool is selected. Up to four sets
of values can be temporarily stored and recalled while the Wizard is open by clicking the
appropriate memory button or pressing the equivalent function key.

Pressing Ctrl+C when the power or pressure response chart is displayed captures the current
results. Pressing Ctrl+V shows or hides previously captured results. Not applicable when room
gain is included.

Press the S key to instantly check the schematic diagram.

To change the components in the branch of a standard passive filter from series to parallel
configuration, double-click on the label below the relevant slider group. To change the alignment
type of an active filter, double-click on the alignment label. To change the slope units from dB per

octave to dB per decade, double-click on the slope label.

To switch a parametric equaliser filter band on or off, double-click on the On / Off label for that
band. To select either a peaking EQ filter, a low shelving filter, a high shelving filter, a low pass



filter or a high pass filter for a given band, double-click on the filter label for that band. Press the
Esc key to hide the green frequency marker.

If any filter band is switched on, current active and parametric equaliser settings (but not passive
and Le Cléac'h filter settings) can be saved to the permanent data record.

If all filter bands are switched off, current passive, active and Le Cléac'h filter settings (but not
parametric equaliser settings) can be saved to the permanent data record.

To change the frequency range, double-click on the chart frequency label. To directly set a slider
control to a specified value, key in the value and then press Enter while the control has the focus.

To quickly move through a slider control value range, press and hold the Home or End key while
the slider has the focus.

To reset a slider control to its baseline value, press B while the control has the focus. To reset all
slider controls to their baseline values, press Alt+B. Current slider control settings and chart
results for the currently selected filter can be saved as a new baseline by pressing Ctrl+Alt+B.

Click the Save button in the Memory window or press the F9 function key to permanently save the
current Filter Wizard settings. Click the Reset button in the Memory window or press the Ctrl+F9
function keys to reset current settings back to the saved settings. Press the F5 function key to
restore all slider controls to their initial default settings.

The active or parametric equaliser filter option can be selected from the Loudspeaker Wizard by
either clicking the Filter Wizard button in the Memory window or pressing the F8 function key.
When the Filter Wizard is selected from the Loudspeaker Wizard, current slider control settings can
be saved as a new baseline by pressing Ctrl+Alt+B. Pressing Ctrl+Alt+B does not change the
chart baseline itself.

|Efficiency

Displays the acoustical output power divided by the electrical input power, or power conversion
efficiency, in percent versus frequency in hertz. Click on the chart to show the efficiency value at a
specified frequency.

Select from the acoustical power chart window.

Previous results are used in comparisons by default. Press Ctrl+C to capture the current results
or Ctrl+R to release captured results. Results can also be captured or released by right-clicking
on the chart.

Press F4 to show or hide the previous or captured results.

|Driver Power

Displays the driver electrical input power in watts versus frequency in hertz. Click on the chart to



show the power value at a specified frequency.

Select from the acoustical power chart window.

Previous results are used in comparisons by default. Press Ctrl+C to capture the current results
or Ctrl+R to release captured results. Results can also be captured or released by right-clicking
on the chart.

Press F4 to show or hide the previous or captured results.

|Sound Pressure

Displays the peak sound pressure at the horn throat, horn mouth, port inlet, port outlet or direct
radiator in pascals versus frequency in hertz. Click on the chart to show the sound pressure value
at a specified frequency. The throat of an offset driver or tapped horn is at S2.

Select from the acoustical power chart window. Not applicable to combined outputs.

Previous results are used in comparisons by default. Press Ctrl+C to capture the current results
or Ctrl+R to release captured results. Results can also be captured or released by right-clicking
on the chart.

Press F4 to show or hide the previous or captured results.

|Particle Velocity

Displays the peak particle velocity at the horn throat, horn mouth, port inlet, port outlet or direct
radiator in metres per second versus frequency in hertz. Click on the chart to show the particle
velocity value at a specified frequency. The throat of an offset driver or tapped horn is at S2.
Select from the acoustical power chart window. Not applicable to combined outputs.

Previous results are used in comparisons by default. Press Ctrl+C to capture the current results
or Ctrl+R to release captured results. Results can also be captured or released by right-clicking
on the chart.

Press F4 to show or hide the previous or captured results.

When selected from the electrical impedance chart window, sets the electrical impedance chart
range. Select Zoom to optimise the scale for the resonance peak.

When selected from the group delay chart window, sets the group delay chart range.

[Impedance Phase



Displays the electrical impedance phase in degrees versus frequency in hertz. Click on the chart
to show the phase value at a specified frequency.

Previous results are used in comparisons by default. Press Ctrl+C to capture the current results
or Ctrl+R to release captured results. Results can also be captured or released by right-clicking
on the chart.

Press F4 to show or hide the previous or captured results.

|Diaphragm Pressure

Displays the peak sound pressure at the driver diaphragm in pascals versus frequency in hertz.

Click on the chart to show the pressure and force at a specified frequency. Total pressure is the
difference between the pressures on the front and rear sides of the diaphragm with phase taken
into account.

Select from the diaphragm displacement chart window.

Previous results are used in comparisons by default. Press Ctrl+C to capture the current results
or Ctrl+R to release captured results. Results can also be captured or released by right-clicking
on the chart.

Press F4 to show or hide the previous or captured results.

|Velocity

Displays the driver diaphragm peak velocity in metres per second versus frequency in hertz. Click
on the chart to show the velocity value at a specified frequency.

Select from the diaphragm displacement chart window.

Previous results are used in comparisons by default. Press Ctrl+C to capture the current results
or Ctrl+R to release captured results. Results can also be captured or released by right-clicking
on the chart.

Press F4 to show or hide the previous or captured results.

|Acceleration

Displays the driver diaphragm peak acceleration in metres per second per second versus
frequency in hertz. Click on the chart to show the acceleration value at a specified frequency.

Select from the diaphragm displacement chart window.



Previous results are used in comparisons by default. Press Ctrl+C to capture the current results
or Ctrl+R to release captured results. Results can also be captured or released by right-clicking
on the chart.

Press F4 to show or hide the previous or captured results.

Sets the phase response chart offset delay correction. Move the slider control to minimum to
show standard wrapped phase. Select from the phase response window.

|Throat Adaptor Designer

Displays the flare profile of a horn throat adaptor transition element, given D1 the entry diameter,
D2 the exit diameter, Al the entry flare tangent angle and A2 the exit flare tangent angle. The
minimum length element is calculated. The profile data can be exported.

|Wavefront Simulator

Models sound wave propagation in horn loudspeakers. Isophase wavefronts are shown.

Click or drag the mouse with 'Mouse = Edit Walls' option selected to add or delete walls. Click or
drag the mouse with 'Mouse = Edit Wave' option selected to add or change wavefronts.
Shift+click the mouse at line end points to specify a straight wall. Ctrl+click the mouse at diagonal
corners to specify a rectangular walled box enclosure. Alt+click the mouse at diaphragm end
points to specify a driver source. Alt+click the mouse twice at the same location to specify a point
source. Shift+Alt+click the mouse to add a source without deleting the previous one.

|Options

Sets the throat chamber and rear chamber resonance masking and default result window options.

|FILE MENU

[New

Creates a new data file.



Opens an existing data file.

|Editor

Moves or copies records from one data file to another, or deletes records from a data file.

|Copy Driver

Copies driver parameter values from the current record to the Clipboard.

|Paste Driver

Pastes driver parameter values from the Clipboard to the current record.
The File menu command is enabled when the input parameters window is in edit mode.

|Copy Driver to Database

Copies driver parameter values from the current record to the driver database.
Not applicable to the default record.

|Paste Driver from Database

Pastes driver parameter values from the driver database to the current record.

The File menu command is enabled when the input parameters window is in edit mode. The
menu command can also be selected by right-clicking any driver parameter label in edit mode.

Searches for records that match the given comment text and filter.

The Page Up, Page Down, Home, End and Enter keys can also be used to move from one record
to another, when the input parameters window is displayed.

Sorts records in comment-ascending alphanumeric order.

[Import Hornresp Record




Loads input parameter data values from an exported record file.

[Import Room Gain Profile

Loads room gain profile data values from a text (.txt) or frequency response data (.frd) file.
The file must not contain any header or footer comment records.

File data records must be listed sequentially, with the first field in the record being a frequency
value and the second field being a room gain value. Additional record fields are disregarded.

Room gain values must be relative to a zero decibel reference point.

Fields in a record can be space or tab delimited, and field values can have either a period or a
comma as the decimal separator.

|Export AkAbak Script

Saves current record input parameter data values to an AkAbak script file. Record must be valid.
Select from the input parameters window.

|Export Hornresp Record

Saves current record input parameter data values to a Hornresp export record file. Record must
be valid. Select from the input parameters window.

|Export Horn Data

Saves schematic diagram data values to a tab-delimited text (.txt) or comma separated values (.
csv) file. Select from the schematic diagram window.

Axial length values for each horn segment increase linearly from zero to the segment length. The
length increment for each segment can be set to a specified value in centimetres.

Con width flare ~ Rectangular cross-section horn segment width changes linearly with axial length.
The height at any point equals the cross-sectional area divided by the width at that point.

Exp width flare ~ Rectangular cross-section horn segment width changes exponentially with axial
length. The height at any point equals the cross-sectional area divided by the width at that point.

Uni width flare ~ Rectangular cross-section horn segment cross-sectional area aspect ratio
changes uniformly with axial length.

Click the Preview button to show the diameter profile for an axisymmetric horn, the width and
height profiles for a rectangular horn, and the petal profile for a petal horn.



The flat profile of the left and right side walls of a rectangular cross-section horn can be
determined by plotting the schematic diagram exported Height / 2 values against Side Len as the
X-axis centre line. The flat profile of the top and bottom horn walls can be determined by plotting
Width / 2 values against Top Len as the X-axis centre line.

The flat profile of a petal horn side wall can be determined by plotting Width / 2 values against
Side Len as the X-axis centre line.

The 2007 flare profile used in the Le Cléac'h horn simulation model becomes slightly inaccurate

near the horn mouth. The error is not large enough to make any practical difference to predicted
results, however for construction purposes the exact axisymmetric profile can be previewed and

exported if required by selecting the Exact Profile option.

|Export All Chart Data

Saves data values for all calculated charts to a tab-delimited text (.txt) or comma separated values
(.csv) file. Frequency values increase logarithmically from 10 to 20000 hertz. Select from any
chart window.

|Export Za + Phase

Saves horn throat acoustical impedance magnitude and phase values to a tab-delimited text (.txt)
file for use with other loudspeaker design software tools. Frequency values increase
logarithmically from 10 to 20000 hertz. Select from the acoustical impedance window.

|Export SPL + Phase

Saves SPL magnitude and phase values to a tab-delimited text (.txt) or frequency response data (.
frd) file for use with other loudspeaker design software tools. Frequency values increase
logarithmically from 10 to 20000 hertz. Select from the acoustical power or acoustical pressure
window.

|Export Ze + Phase

Saves electrical impedance magnitude and phase values to a tab-delimited text (.txt) or
impedance response data (.zma) file for use with other loudspeaker design software tools.
Frequency values increase logarithmically from 10 to 20000 hertz. Select from the electrical
impedance window.

Prints the input parameter values and displayed schematic diagram or chart.



Closes the Hornresp application.

[LOUDSPEAKER MODELS

|Direct Radiator in an Infinite Baffle

Set Ang = 2 x Pi, S1to L45 = 0 and Vrc and/or Lrc = 0.

|Direct Radiator in a Closed-Box Enclosure

Select the 'Rear Lined' option from the Chamber tool and set S1 to L45 = 0 and Vrc and Lrc > 0.
To specify acoustical lining material in the rear chamber set Fr and Tal > 0.

|Direct Radiator in a Vented-Box Enclosure

Select the 'Rear Vented' option from the Chamber tool and set S1 to L45 = 0 and Vrc, Lrc, Ap and
Lpt > 0.

By default, the combined direct radiator plus port acoustical power output is calculated. The
Output tool can be used to determine the direct radiator output or the port output. An end
correction is added to the Lpt rear chamber port tube length where appropriate.

|Sixth or Eighth Order Band Pass Enclosure

Select the BP6 or BP8 option from the Driver Arrangement tool or press the Ctrl key and double-
click the CH label in edit mode to set the BP6 or BP8 flag.

Press F5 or click the Wizard button to open the Loudspeaker Wizard. Set the chamber, port,
amplifier and filter slider control values by moving the sliders or by directly keying in the value and
then pressing Enter while the control has the focus.

The enclosure is modelled as shown in the schematic diagram.

|Aperiodic Bi-Chamber Enclosure

Select the ABC option from the Driver Arrangement tool or press the Ctrl key and double-click the
BP8 label in edit mode to set the ABC flag.



Press F5 or click the Wizard button to open the Loudspeaker Wizard. Set the chamber, port,
amplifier and filter slider control values by moving the sliders or by directly keying in the value and
then pressing Enter while the control has the focus.

The enclosure is modelled as shown in the schematic diagram.

[Damped Transmission Line Enclosure

Select the offset driver option and use the Loudspeaker Wizard to add absorbent filling material to
horn segments as required.

Set L12 = 0.01 cm if the driver is not offset.
By default, the combined transmission line plus direct radiator acoustical power output is calculated
The Output tool can be used to determine the transmission line output or the direct radiator

output.

|Front-Loaded Horn

Set Vrc and Lrc > 0.

To specify acoustical lining material in the rear chamber select the 'Rear Lined' option from the
Chamber tool and set Fr and Tal > 0.

To specify a throat adaptor between the throat chamber and the horn throat select the 'Throat
Adaptor' option from the Chamber tool and set Ap1, Lp, Vic and Atc > 0.

By default, if no rear chamber is specified, the combined horn plus direct radiator acoustical power
output is calculated. The Output tool can be used to determine the horn output or the direct
radiator output.

|Back-Loaded Horn

Set Vrc and/or Lrc = 0.

To specify a throat adaptor between the throat chamber and the horn throat select the 'Throat
Adaptor' option from the Chamber tool and set Ap1, Lp, Vic and Atc > 0.

By default, the combined horn plus direct radiator acoustical power output is calculated. The
Output tool can be used to determine the horn output or the direct radiator output.

|[Horn-Loaded Vented-Box Enclosure With Port Exit Located Outside Horn Mouth

Select the 'Rear Vented' option from the Chamber tool and set Vrc, Lrc, Ap and Lpt > 0.



By default, the combined horn plus port acoustical power output is calculated. The Output tool can
be used to determine the horn output or the port output. An end correction is added to the Lpt rear
chamber port tube length where appropriate.

[Horn-Loaded Vented-Box Enclosure With Port Exit Located Inside Horn Mouth

Select the tapped horn option and set Vrc, Lrc, Ap and Lpt > 0.
Set L12 = 0.01 cm if the driver is not offset.

[Mass-Loaded Horn

Specify the mouth cover plate as a conical segment having negative flare (mouth area < throat
area) and a length of 0.01 cm, and the mouth mass-loading port tube as a cylindrical exponential
segment having zero flare (mouth area = throat area).

|Offset Driver Horn

Specify at least two conical, exponential and/or parabolic flare segments connected in series, and
select the offset driver option from the Driver Arrangement tool or double-click the Nd, TH, TH1,
CH, ME1, ME2, BP6 or BP8 label in edit mode to set the OD flag.

The driver entry point is at S2. Vtc and Atc can be used to specify a chamber between the driver
diaphragm and the throat entry point. Apl and Lp can be used to specify a port opening between
the chamber and the horn (not required if the cross-sectional area of the opening is equal to Atc).

By default, if no closed rear chamber is specified, the combined horn plus direct radiator or port
acoustical power output is calculated. The Output tool can be used to determine the horn output
or the direct radiator or port output. An end correction is added to the Lpt rear chamber port tube
length where appropriate.

The Loudspeaker Wizard tool can be used to change the driver position without altering the horn
length or flare.

|Two-Way or Three-Way Multiple Entry Horn

CoEntrant, Unity and Synergy loudspeakers are examples of multiple entry horn systems.

Specify the horn system, horn throat driver assembly, associated chambers, amplifier and filter
using a Nd record.

Specify the first offset driver assembly, associated chambers, amplifier and filter using a ME1
record. The MEL1 values of Vrc, Ap, Apl, Vic and Atc are the sum totals of the chamber volumes
and areas for all the ME1 drivers.



Specify the second offset driver assembly, associated chambers, amplifier and filter using a ME2
record. The ME2 values of Vrc, Ap, Apl, Vtc and Atc are the sum totals of the chamber volumes
and areas for all the ME2 drivers.

Select the ME1 option from the Driver Arrangement tool or press the Ctrl key and double-click the
Nd label in edit mode to set the MEL1 flag.

Select the ME2 option from the Driver Arrangement tool or press the Ctrl key and double-click the
MEL1 label in edit mode to set the ME2 flag.

A ME1 or ME2 record can be activated or deactivated by clicking on the designated button.
Activating a ME1 record deactivates any previously activated ME1 record. Activating a ME2 record
deactivates any previously activated ME2 record.

The Multiple Entry Horn Wizard command is included on the input parameters window Tools menu
list when a Nd record with at least two segments is selected, and a ME1 record is active.

|Tapped Horn

Specify three or four conical, exponential and/or parabolic flare segments connected in series, set
Vrc and/or Lrc = 0 and select the tapped horn option from the Driver Arrangement tool or double-
click the Nd, OD, CH, ME1, ME2, BP6 or BP8 label in edit mode to set the TH flag. The TH label
can be double-clicked to set the optional TH1 flag.

Driver entry points are at S2 and S3 for a three segment TH horn, S2 and S4 for a four segment
TH horn, and S2 and S3 for a four segment TH1 horn.

Vtc and Atc can be used to specify a chamber between the driver diaphragm and the throat entry
point. Apl and Lp can be used to specify a port opening between the throat chamber and the
horn (not required if the cross-sectional area of the opening is equal to Atc).

Vrc and Lrc can be used to specify a chamber between the driver diaphragm and the mouth entry
point. Ap and Lpt can be used to specify a port opening between the mouth chamber and the horn
(not required if the cross-sectional area of the opening is equal to Vrc / Lrc).

The Loudspeaker Wizard tool can be used to change the driver position without altering the horn
length or flare.

|Compound Horn

Select the compound horn option from the Driver Arrangement tool or double-click the Nd, OD, TH,
TH1, ME1, ME2, BP6 or BP8 label in edit mode to set the CH flag. Horn 1 is specified using
segment 1 plus segments 2 and 3 if required. Horn 2 is specified using segment 4.

By default, the combined horn 1 plus horn 2 acoustical power output is calculated. The Output
tool can be used to determine the horn 1 output or the horn 2 output.

Converted by Zero D, with thanx to David J McBean for an Excellent program,
& the DIY community for their ongoing inputs !
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